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Important User Information
Solid state equipment has operational characteristics differing from those of electromechanical equipment. Safety Guidelines 
for the Application, Installation and Maintenance of Solid State Controls (publication SGI-1.1 available from your local Rockwell 
Automation sales office or online at http://www.rockwellautomation.com/literature/) describes some important differences 
between solid state equipment and hard-wired electromechanical devices. Because of this difference, and also because of the 
wide variety of uses for solid state equipment, all persons responsible for applying this equipment must satisfy themselves that 
each intended application of this equipment is acceptable.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Rockwell Automation, Allen-Bradley, Rockwell Software, Powermonitor 1000, Powermonitor 3000, PanelView Component, ControlLogix, RSLogix 500, RSEnergyMetrix, RSLinx Classic, RSPower, 
and TechConnect are either trademarks or registered trademarks of Rockwell Automation, Inc.

Trademarks not belonging to Rockwell Automation are property of their respective companies.

WARNING
Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, 
which may lead to personal injury or death, property damage, or economic loss.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

ATTENTION
Identifies information about practices or circumstances that can lead to personal injury or death, property damage, 
or economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence

SHOCK HAZARD
Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may 
be present.

BURN HAZARD
Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach 
dangerous temperatures.

http://literature.rockwellautomation.com/idc/groups/literature/documents/in/sgi-in001_-en-p.pdf
http://www.rockwellautomation.com/literature/


Where to Start

Follow the path below to complete your connected components building block.

Chapter 2 System Validation and Application Tips

Connected Components 
Building Blocks, publication 

CC-QS001

Chapter 1 Powermonitor 1000 Device Configuration
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Preface

Introduction This quick start is designed to provide a way to implement and use a 
connected component for energy management. To assist in the design 
and installation of your system, application files and other information 
are provided on the Connected Components Building Blocks 
Overview CD, publication CC-QR001. The CD provides bills of 
materials (BOM), CAD drawings for panel layout and wiring, control 
programs, Human Machine Interface (HMI) screens, and more. With 
these tools and the built-in best-practices design, the system designer 
is free to focus on the design of their machine control and not on 
design overhead tasks. The beginning of each chapter contains the 
following information. Read these sections carefully before beginning 
work in each chapter:

• Before You Begin - This section lists the steps that must be 
completed and decisions that must be made before starting that 
chapter. The chapters in this quick start do not have to be 
completed in the order in which they appear, but this section 
defines the minimum amount of preparation required before 
completing the current chapter.

• What You Need - This section lists the tools that are required to 
complete the steps in the current chapter. This includes, but is 
not limited to, hardware and software.

• Follow These Steps - This illustrates the steps in the current 
chapter and identifies which steps are required to complete the 
examples.

Use this Energy Management Connected Components Building Block 
Quick Start in conjunction with the Connected Components Building 
Blocks Quick Start, publication CC-QS001.

Refer to Additional Resources on page 9 for a listing of quick starts.
Publication CC-QS0017A-EN-P - March 2010 7
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Preface
Conventions Used in This 
Manual

This manual uses these conventions.

Convention Meaning Example

Check or uncheck To activate or deactivate a checkbox. Check Disable Keying.

Click Click the left mouse button once while the cursor is positioned 
on object or selection. Click Browse. 

Select Using the mouse to highlight a specific option. Select the New Module folder.

Enter What you type. Enter your choice.

> Use this symbol to indicate the sub-menu name. Choose File > Menu > Options. 
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Preface
Additional Resources

Resource Description

Connected Components Building Blocks Quick Start, 
publication CC-QS001

Provides information on how to select products and gain access to panel and wiring 
information.

Connected Component Building Blocks Overview 
CD, publication CC-QR001

Provides files for the Connected Component Building Blocks.

MicroLogix 1400 Programmable Controllers User 
Manual, publication 1766-UM001

Provides information on using the MicroLogix 1400 programmable controller.

MicroLogix 1400 Programmable Controllers 
Installation Instructions, publication 1766-IN001

Provides information on installing the MicroLogix 1400 programmable controller.

MicroLogix 1400 Programmable Controllers 
Instruction Set Reference Manual, publication 
1766-RM001

Provides information on using the MicroLogix 1400 programmable controller 
RSLogix 500 instruction set.

http://www.ab.com Provides access to the Allen-Bradley website.

Powermonitor 1000 User Manual, 
publication 1408-UM001

Provides information for using the Powermonitor 1000 device.

Powermonitor 1000 Installation Instructions, 
publication 1408-IN001

Provides information for installing the Powermonitor 1000 device.

PanelView Component Operator Terminals User 
Manual, publication 2711C-UM001

Provides information on using the PanelView Component HMI terminals.

PanelView Component Installation Instructions, 
publication 2711C-IN001

Provides installation information for the PanelView Component terminal.

RSEnergyMetrix Getting Results Guide, publication 
ENEMTX-GR001

Provides information about using RSEnergyMetrix software.

Current Transformer Selection Matrix, publication 
1411-SG001

Provides a selection matrix for choosing your current transformer.

http://www.rockwellautomation.com/
knowledgebase

Provides access to self-service support.

http://www.rockwellautomation.com/components/
connected

Provides access to the Connected Components website.
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http://literature.rockwellautomation.com/idc/groups/literature/documents/qs/cc-qs001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1408-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/qs/cc-qs001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2711c-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/2711c-um001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1408-in001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/rm/1766-rm001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1766-in001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/in/2711c-in001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/gr/enemtx-gr001_-en-p.pdf
http://literature.rockwellautomation.com/idc/groups/literature/documents/sg/1411-sg001_-en-p.pdf
http://www.ab.com/
http://www.rockwellautomation.com/knowledgebase/
http://www.rockwellautomation.com/components/connected
http://literature.rockwellautomation.com/idc/groups/literature/documents/um/1766-um001_-en-p.pdf


Preface
Notes:
10 Publication CC-QS0017A-EN-P - March 2010



Chapter 1

Powermonitor 1000 Device Configuration

Introduction

In this chapter, you will learn to configure a Powermonitor 1000 device.

For other configuration parameters such as, Wiring Mode WYE, Delta, Potential/Current 
Transformer ratios, Demand periods, and advanced configuration, you need to consult these 
Powermonitor 1000 publications:

• Bulletin 1408 Powermonitor 1000 User Manual, publication 1408-UM001

• Powermonitor 1000 Unit Installation Instructions, publication 1408-IN001

Before You Begin

• Review the Energy Management Connected Component Building Blocks common folder to 
review important background information regarding your Powermonitor device and software 
package

• Select hardware and wire devices. Refer to the Powermonitor 1000 Unit Installation 
Instructions, publication 1408-IN001, for reference.
Publication CC-QS0017A-EN-P - March 2010 11
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Chapter 1 Powermonitor 1000 Device Configuration
What You Need

• Powermonitor 1000 device

• PanelView Component HMI terminal

• RSLogix 500 and RSEnergyMetrix software

• Current transformers and potential transformers, if required (refer to the Powermonitor 1000 
User Manual, publication 1408-UM001)

• Product manuals
– Bulletin 1408 Powermonitor 1000 User Manual, publication 1408-UM001
– Powermonitor 1000 Unit Installation Instructions, publication 1408-IN001
– PanelView Component User Manual, publication 2711C-UM001

Follow These Steps

Follow these paths to configure the Powermonitor device and PanelView Component device in 
your energy system.

Start

Configure the 
EtherNet/IP Address, 

page 15

Configure Analog 
Inputs, page 16

Configure Advanced 
Device Parameters, 

page 17

Configure the Date 
and Time, page 18

Configure a Powermonitor 1000 Device

Configure RS-485, 
page 14

Configure a 
Powermonitor 1000 

Device, page 13
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Powermonitor 1000 Device Configuration Chapter 1
Configure a Powermonitor 1000 Device

This section shows you how to configure parameters of a Powermonitor 1000 device by using its 
internal Display and Configuration web page. Certain settings are needed for the 
Powermonitor 1000 device to meter accurately, communicate correctly, and work with 
RSEnergyMetrix software properly. You will set the network configuration, Voltage mode, PT and 
CT ratios, demand values, and the date and time. Your application may require additional 
configuration.

Follow these steps to configure Powermonitor 1000 device parameters.

1. Launch the Internet browser on your computer.

2. In the Address field, type the IP address of your Powermonitor 1000 device.

The default IP address is 192.168.254.xxx, where xxx is the unit’s ID. The default address 
simplifies the task of making the initial connection to the unit from a personal computer.

TIP Network configuration is provided for the Powermonitor 1000 device on the Ethernet network. For other 
communication options, refer to the Powermonitor 1000 Unit Installation Instructions, publication 
1408-IN001.

TIP You can check the IP address of the Powermonitor 1000 device from its display or by 
using RSLinx Classic software and configuring an EtherNet/IP driver.

http://192.168.254.23
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Chapter 1 Powermonitor 1000 Device Configuration
Configure RS-485

Follow these steps to configure RS-485 in a Powermonitor 1000 device.

1. Choose Configure Options > Communication > RS-485 Communications to access the RS-485 
Configuration page.

2. Enter the default password of 0 or another valid password to access Edit mode.

3. Enter the following parameter values in the RS-485 Configuration table. 

This configuration is used for a PanelView Component 3-inch application.

– PM1000 Protocol - DH485 
– Serial Delay - 5 ms
– Baud Rate - 19200
– Serial Address - 1
– Serial Data Format - 8-1-E
– Intercharacter Timeout - 0
14 Publication CC-QS0017A-EN-P - March 2010



Powermonitor 1000 Device Configuration Chapter 1
Configure the EtherNet/IP Address

Follow these steps to configure the EtherNet/IP address of a Powermonitor 1000 device.

1. Choose Configure Options> 
Communication > Ethernet 
Communications to access the 
Ethernet Configuration page.

2. Enter the default password of 0 or another 
valid password to access Edit mode.

3. Enter appropriate values in the IP Address 
Byte fields.

For this example, the IP address is 10.10.10.1 
for the first Powermonitor 1000 device.

4. Enter the Subnet Mask and Gateway IP addresses as required.

5. Click Submit to send the parameter changes to the Powermonitor 1000 device.

6. Browse to the new IP address from your web browser.

The IP address is shown on the default LCD display screen.

TIP The password appears as asterisks 
(*). If you don’t know the password, 
call Rockwell Automation technical 
support for assistance.

TIP You will lose communication to the Powermonitor 1000 device. You must enter the new IP 
address in the Address field of your web browser to re-establish communication with the device.

1
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Chapter 1 Powermonitor 1000 Device Configuration
Configure Analog Inputs

Follow these steps to configure the Voltage mode, PT ratios, and CT ratios for the Powermonitor 
1000 device. The Analog Input Set-up Parameters table on page 17 shows the analog input 
parameters and example settings.

1. From the Configure Options menu, 
choose Analog Input to display the 
Analog Input Configuration page.

2. Enter the default password of 0 or another 
valid password to access Edit mode.

3. Enter the value of the Voltage Mode you 
are using.

4. Set elements 2, 3, and 4 to configure the 
PT and CT parameters.

5. Click Submit to send the parameter changes to the Powermonitor 1000 device.

TIP The password appears as asterisks 
(*). If you don’t know the 
password, call Rockwell 
Automation technical support for 
assistance.

600
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Powermonitor 1000 Device Configuration Chapter 1
Configure Advanced Device Parameters

Follow these steps to configure advanced demand parameters for the Powermonitor 1000 device. 
These settings include demand source, demand period length, and the number of demand 
periods to average for the demand calculation. The Advanced Device Configuration Parameters 
table on page 18 shows the demand parameters and example settings.

1. From the Configure 
Options menu, choose 
Advanced to access the 
Advanced Configuration 
page.

2. Enter the default password of 0 or another 
valid password to access Edit mode.

Analog Input Set-up Parameters

Parameter Range Default Example Settings

Password 0…9999 0 0

Voltage Mode

0…6
0 = Direct Delta 
1 = Open Delta 
2 = Wye
3 = Single Phase
4 = Demo, simulated results
5 = 1PT1CT-LL
6 = 1PT1CT-LN

2 2

PT Primary 1.0…50,000 480 480

PT Secondary 5.00…50,000 480 480

CT Primary 5.00…50,000 5 600

System PF Setting
0 = Lead (-97…89)
1 = High (-85…98)
2 = Low (-52…-95)

2 = Low 2

TIP The password appears as asterisks 
(*). If you don’t know the password, call 
Rockwell Automation technical support 
for assistance.
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Chapter 1 Powermonitor 1000 Device Configuration
3. Set appropriate values for the demand parameters (elements 14, 15, and 16).

For this example, accept the default parameters as shown.

4. Click Submit to send the parameter changes to the Powermonitor 1000 device.

Configure the Date and Time

Follow these steps to configure the date and time for the Powermonitor 1000 device. The Date 
and Time Set-up Parameters table on page 19 shows the date and time parameters, and example 
settings.

1. From the Configure Options 
menu, choose Date and Time to 
access the Date and Time 
Configuration page.

Advanced Device Configuration Parameters

Parameter Range Default Example Settings

Password 0…9999 0 0

Demand Source

0…3
0 = Internal Timer
1 = Status Input 2
2 = Controller Command
3 = Ethernet Demand Broadcast

0 0

Demand Period Length 0…99 min 15 min 15

Number of Demand Periods 1…15 1 1

Forced Demand Sync Delay 0…90 s 10

Demand Broadcast Master Select 0…1 0

Broadcast Port Number
(Ethernet Setup) 300…400 300
18 Publication CC-QS0017A-EN-P - March 2010



Powermonitor 1000 Device Configuration Chapter 1
2. Enter the default password of 0 or another 
valid password to access Edit mode.

3. Configure the date and time parameters 
accordingly.

4. Click Submit to send the parameter changes 
to the Powermonitor 1000 device.

 

Additional Resources

Refer to page 9 for a listing of product and information resources.

TIP The password appears as asterisks (*). 
If you don’t know the password, call 
Rockwell Automation technical support 
for assistance.

Date and Time Set-up Parameters

Parameter Range Default Example Settings

Password 0…9999 0 0

Date: Year 2001…2100 2005

Date: Month 1…12 1

Date: Day 1…31 0

Time: Hour 0…23 0

Time: Minute 0…59 0

Time: Seconds 0…59 0

Time: Hundreths 0…59 0

TIP For a full Powermonitor 1000 LCD screen display and configuration map, see pages 30…32 of the 
Powermonitor 1000 Installation Instructions, publication 1408-IN001.
Publication CC-QS0017A-EN-P - March 2010 19

http://literature.rockwellautomation.com/idc/groups/literature/documents/in/1408-in001_-en-p.pdf


Chapter 1 Powermonitor 1000 Device Configuration
Notes:
20 Publication CC-QS0017A-EN-P - March 2010



Chapter 2

System Validation and Application Tips

Introduction

In this chapter, you will configure the communication of your application. You will learn how to:

• connect a Powermonitor 1000 device to a PanelView Component terminal. 
• configure RSEnergyMetrix software to properly log your Powermonitor 1000 device data.

Before You Begin

• Review the PanelView Component User Manual, publication 2711C-UM001
• Optional - Install RSEnergyMetrix software (Review the RSEnergyMetrix User and 

Installation Manual, publication ENEMTX-GR001)
• Configure Powermonitor 1000 devices, refer to Chapter 1
• Configure the PanelView Component terminal

What You Need

• Personal computer with Internet access for launching and using RSEnergyMetrix software
• RSEnergyMetrix CD, catalog number 9307-ENEMTXCD
• RSEnergyMetrix online help and Getting Results Guide, publication ENEMTX-GR001
• USB flash drive (for loading the PanelView application)
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Chapter 2       System Validation and Application Tips
Follow These Steps

Follow these steps to verify that communication is occurring between your devices.

Powermonitor 1000 
Device to PanelView 

Component Configuration

PanelView Component C300 
Screens Quick Navigation 

for Powermonitor 1000 
Device

page 23

page 24

page 25

page 26

page 28

page 30

page 31

page 32

page 33

page 35

Start

Powermonitor 1000 
Device to RSEnergyMetrix 

Software Configuration

Configure Communication 
Drivers

Configure a Powermonitor 
1000 Device

Copy Devices

Creating Electric Meters 
in RSEnergyMetrix 

Software

Create a Powermonitor 
1000 Electric Meter

Assign Meter Tags to a 
Powermonitor 1000 

Electric Meter

Copy Meters and Tags
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System Validation and Application Tips        Chapter 2
Powermonitor 1000 Device to PanelView Component Configuration

Loading Powermonitor 1000 Standalone Application to a PanelView Component 
Terminal
Follow these steps to download the Powermonitor 1000 device preconfigured PanelView 
Component project to 3 inch touch terminal.

1. Power up the PanelView Component 3 inch terminal and Powermonitor 1000 device.

2. Verify that the PanelView Component terminal is connected to the Powermointor 1000 
device over the RS-485 network.

3. Verify that the Powermonitor 1000 device is configured properly for the RS-485 network. 

This configuration was done on page 14.

• PM1000 Protocol - DH485
• Serial Delay - 5 ms
• Baud Rate - 19200
• Serial Address - 1
• Serial Data Format - 8-1-E
• Intercharacter Timeout - 0
• Maximum Node Address - 4

TIP The PanelView Component terminal is powered with a 24V DC supply. The PanelView Component HMI 
power wiring is illustrated in the Connected Building Block CD.

Customer supplied Ethernet 
switch or fiber to Ethernet 
network or Ethernet drop 
connection used for data 
logging to RSEnergyMetrix, 
RSPower, or other software 
application, such as HMI or 
controller programs.

1585J-M8TBJM-xx 
Allen-Bradley Patch Cable
xx = Length in meters or 
equivalent

Powermonitor 1000 Device HMI

RS-485 Wiring
2/C Shielded Cable

TIP Powermonitor 1000 firmware revision 2.13 or later is supported. The Powermonitor 1000 device can be 
updated by using the ControlFlash utility. The latest upgrade can be obtained from 
http://www.ab.com/PEMS/downloads.html.
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Chapter 2       System Validation and Application Tips
4. Copy the PanelView Component application ‘PM1000_C300.cha’ from the Component 
Building Block CD to the root of the USB flash drive. 

5. Plug the USB drive into the PanelView Component terminal. 

The USB connection is on the back side of PanelView C300 terminal.

6. Configure the Screensaver/Start-up application as desired from the PanelView Component 
HMI settings, then run the Powermonitor 1000 application file.

7. Verify that the PanelView Component terminal is reading data from the Powermonitor 1000 
device.

This flowchart shows the PanelView Component terminal screen navigation.

PanelView Component C300 Screens Quick Navigation for Powermonitor 1000 Device

TIP The application was developed for a PanelView Component touch-screen terminal only.

 To transfer the application to a PanelView Component HMI, see the PanelView Component Quick Start, 
publication CC-QS001.

Go to Config > File Manager > Source (USB) > Selected PM1000_C300.cha file, and copy it to the internal 
memory of the PanelView Component HMI.

TIP The RS-485 TX/RX status indicators should be blinking on the Powermonitor 1000 device.

Compare the metering values from the Powermonitor 1000 LCD display or web page against the PanelView 
Component terminal. The start-up screen has Average Line-to-Line Voltage, Average Line Current, and Total 
Real Power values. Make sure that there are no asterisks ‘*’on the PanelView Component screen.

An asterisk ‘*’ indicates:

• a communication error.
• the value has more significant digits than HMI applications.

START UP SCREEN
Avg Line Voltage, Current,

Total Real Power

Menu Screen 1

METERING POWERMETERING VIF
(Volts, Current, Freq)

Volts Line to Neutral
Volts Line to Line

Line Currents
Average Volts/Current

Voltage/Current Unbalance
Frequency/Rotation

Real Power (kW)
Reactive Power (kVAR)
Apparent Power (kVA)

Total kW/kVAR/kVA
Power Factor

Real Energy Net (kWh)
Reactive Energy Net (kVARh)
Apparent Energy Net (kVAh)

kW, kVAR Demand
PowerFactor, kVA Demand

Date Time
Input Count

Comm Parameters
Meter Diagnostic

Menu Screen 1
Goto Config

METERING ENERGY METERING DEMAND NEXT MENU START UP SCREEN
24 Publication CC-QS0017A-EN-P - March 2010
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System Validation and Application Tips        Chapter 2
Powermonitor 1000 Device to RSEnergyMetrix Software Configuration

Overview of Devices

Devices are physical entities that RSEnergyMetrix software communicates with over a network. 
Setting up a device in RSEnergyMetrix software establishes communication and creates database 
definitions for the device. 

Devices may be directly connected to the server over a network if the RSEnergyMetrix server is 
also on the network through an appropriate network interface and you have configured the 
appropriate RSLinx Classic device drivers. Devices routed through a ControlLogix gateway or 
RSLinx Classic gateway are also considered directly connected devices.

Device Classes

RSEnergyMetrix software uses device classes to determine how to interact with a particular 
device. The device class includes the device family, communication type, and specifies whether 
the device has a clock that can be synchronized. The device classes covered in this quick start 
include a Powermonitor 1000 device.

For a complete list of device classes, refer to:

• RSEnergyMetrix Getting Results Guide, publication ENEMTX-GR001.
• RSEnergyMetrix Online Help provided with RSEnergyMetrix software.
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Configure Communication Drivers

Before setting up devices, you need to configure the drivers required for communication. This 
example uses the RSLinx Classic Ethernet driver for the Powermonitor 1000 device.

Configure the RSLinx Ethernet Driver

Follow these steps to configure the RSLinx Classic Ethernet driver.

1. Open RSLinx Classic software by 
clicking its icon in the Windows 
system tray (SysTray).

2. From the Communications menu, 
choose Configure Drivers.

3. From the Available Driver 
Types pull-down menu, 
choose Ethernet Devices.

4. Click Add New.

5. Click OK to accept the default 
driver AB_ETH-1.
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6. Enter the IP address of your first 
device (station).

7. Click Add New to enter the IP 
address for each additional device 
you want to add, then click OK.

8. Click OK when done entering IP 
addresses.

9. Click Close to exit the Configure 
Drivers dialog box.
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Configure a Powermonitor 1000 Device

Follow these steps to configure a Powermonitor 1000 device. 

1. Expand the Devices folder 
on the System tab.

2. Navigate to and select the 
appropriate group or 
domain.

In this example, select the 
Electricity group under the 
Engineering subdomain.

3. Click the Add a device link.

4. From the Parent group pull-
down menu, choose a 
subdomain or group.

For this example, choose 
Electricity.

5. Check the boxes as shown.

The checkboxes vary by 
device type.

If the device will not be 
connected during 
configuration, clear the Enable 
device checkbox to avoid 
timeout errors.

6. From the Device class pull-
down menu, choose a device.

For this example, choose 
Powermonitor 1000 (EM3) on 
EtherNet/IP.

7. Enter a name for the device.

For this example, enter Boiler House.

8. Enter the Time zone and Time sync interval.

Devices with internal clocks may be time-synched, such as Powermonitor devices and 
controllers.

Device password applies only to the 
Powermonitors. The default of zero matches 
the default power monitor password
28 Publication CC-QS0017A-EN-P - March 2010



System Validation and Application Tips        Chapter 2
9. Enter the communication path 
to the device.

For this example, the 
communication path to the first 
Powermonitor 1000 EM3 device 
is AB_ETH-1\10.10.10.1.

10. Modify other communication settings as needed.

For details, refer to the RSEnergyMetrix software help.

11. Click Save.

The Boiler House device appears 
under Electricity.

12. If the device is connected to the network, 
click Test Connection to verify 
communication with the device.

If you see ‘connection failed’, try again. If the test times out, check that you entered the 
correct communication path in step 9 and that the device is online. Try to access the 
Powermonitor device's web page or try to ping it from the RSEnergyMetrix server.
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Copy Devices

Follow these steps to create additional devices by using the copy function. For the Efficient 
Industries Plant 1 example, you will use the copy function to create five remaining Powermonitor 
1000 devices (Power House, Production 1, Production 2, Shipping/Receiving/DC, MCC2).

1. Select an existing device, 
and then click Copy. 

For this example, select 
the Boiler House device.

2. Change the name of the 
copied device.

For this example, replace 'Copy of 
Boiler House' with ‘Power House’.

3. Change the Communication path to 
match the device for this example.

4. If the device will not be connected 
during configuration, clear the 
Enable device checkbox to avoid 
timeout errors.

5. Click Save.

The Power House device 
appears under Electricity.
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6. For this example, repeat step 1 through step 5 to copy the remaining Powermonitor 1000 
devices.

Change the name and communication path to each device as shown in the table. Note that 
all devices fall under the Electricity parent group except for the MCC 2 device that is under 
Fuels.

Six Powermonitor 1000 
devices and one 
Powermonitor 3000 device 
appear under the 
appropriate groups.

Creating Electric Meters 
in RSEnergyMetrix Software

You will now create meters for Powermonitor 1000 devices 
and assign tags to those meters.

Parent Group Name Communication Path

Electricity Production 1 AB_ETH-1\10.10.10.3

Electricity Production 2 AB_ETH-1\10.10.10.4

Electricity Shipping/Receiving/DC AB_ETH-1\10.10.10.5

Fuels MCC 2 AB_ETH-1\10.10.10.6

This is the Powermonitor 3000

PM 1000

PM 1000
PM 1000
PM 1000
PM 1000

PM 1000

Boiler House (PM 1000)

Production 1 (PM 1000)
Production 2 (PM 1000)
Shipping/Receiving DC (PM 1000)

Electricity (Group)

Power House (PM 1000)
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Create a Powermonitor 1000 Electric Meter

Follow these steps to create a Powermonitor 1000 electric meter. 

1. Click the Meters tab.

2. Navigate to and select a 
group to assign the meter.

For this example, select 
Electricity under the 
Engineering subdomain.

3. Click the Meters tab on 
the right.

4. Click the Add a new 
meter link.

5. Select the Parent group.
For this example, select 
Electricity.

6. From the Type pull-down menu, 
choose the meter type.
For this example, choose Electric.

7. From the Device pull-down 
menu, choose the device 
associated with the meter.
For this example, choose 
Boiler House.

8. Enter a meter name.
For this example, enter Boiler House Meter.

9. Click Save.

10. Confirm the meter was 
created in the correct group.
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Assign Meter Tags to a Powermonitor 1000 Electric Meter

You will now assign tags to a Powermonitor 1000 electric meter. For this example, Real Energy 
Net, Reactive Energy Net, and Real Power Demand are assigned to the Boiler House Meter. 

1. Select the meter to assign tags.

For this example, select Boiler House Meter.

2. Click the Meter Setup tab.

3. Click the Add a new meter 
tag link.

4. Verify that the Meter tag type is Device.

5. From the Meter tag type pull-down 
menu, choose Real Energy Net.

For a Powermonitor device, the rest of 
the settings are autofilled. 

Do not change these autofill values. 
Changing the values may prevent 
logging of the tag or cause incorrect 
data to be logged.

The log rate is set to the default log rate 
of the meter’s assigned group. It is 
typically the utility demand interval 
rate.

Refer to the RSEnergyMetrix software 
help before changing the log rate or 
maximum consumption per hour. 

6. Click Save.
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7. Click Add when the screen 
refreshes.

8. Repeat step 4 through step 7 to add the remaining tags:
• Reactive Energy Net
• Real Power Demand

These are typical tags for electric meters.

9. When done, click the Return to 
meter screens link or the meter tag.

The tags just entered 
appear on the Meter 
Setup tab.

For this example, these 
tags appear.

10. Click the Meter Data tab to verify 
that the meter data is being 
logged.

The data will not appear until the 
next logging interval has occurred.

Another way to check the data is 
to return to the Meter Setup tab 
and click the Read device tags link 
just above the list of meter tags.

You can click Current Date/Time 
to refresh the data.
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Copy Meters and Tags

Meters with the same device class and tags can be copied. It’s a real time saver to create the first 
meter and its tags, then use the copy function to create the rest of the meters.

For this example, the Powermonitor 1000 electric meters all 
use the Real Energy Net, Reactive Energy Net, and Real 
Power Demand tags. You will copy the Boiler House meter 
and tags to create the Power House, Production 1, 
Production 2, and Shipping/Receiving/DC electric meters. 
The tags are copied with the meter.

1. Select the meter to copy.

For this example, select Boiler 
House under the Electricity group.

2. Click the Meter Setup tab.

3. Click Copy.

A copy of the meter is 
created under the selected 
group with the name 
'Copy of Boiler House 
Meter'.

Electric Main (PM 3000)
Boiler House (PM 1000)

Production 1 (PM 1000)
Production 2 (PM 1000)
Shipping/Receiving/DC (PM 1000)

Electricity (Group)

Data Center (OPC Server)

Power House (PM 1000)
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4. Change the device to Power 
House.

5. Change the meter name to 
Power House Meter.

6. Click Save. 

The copied meter and its tags 
are created under the Electricity 
group with the new name.

7. Repeat step 1 through step 6, copy the rest of the Powermonitor 1000 electric meters. 

The Real Energy Net, Reactive Energy Net, and Real Power Demand tags are automatically 
copied with each device. 

8. Change the device name and meter name as shown in the table.

For this example, the electric meter listing looks 
like this.

Additional Resources

Refer to page 9 for a listing of product and information resources.

Meter Parent Group Device Name

Production 1 Electricity Production 1 Production 1 Meter

Production 2 Electricity Production 2 Production 2 Meter

Shipping/Receiving/DC Electricity Shipping/Receiving/DC Shipping/Receiving/DC Meter

TIP Remember that the device class must be the 
same in the source and copied meters, 
otherwise the meter tag addressing will be 
incorrect in the copied meter.

Copied Meters
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Appendix A

Frequently Asked Questions

Introduction

This appendix provides some frequently asked questions regarding using a Powermonitor 1000 
device and a PanelView Component HMI terminal.

1. When I click the Navigation links in the PanelView Component HMI, why does it not bring 
up the correct display? 

A: Calibrate the touch screen on your PanelView Component HMI. Detailed instructions to 
re-calibrate the touch screen can be found in the PanelView Component HMI User 
Manual, publication 2711C-UM001. (Reference page 9.)

2. What does ‘Data Access Error for Alias…’ mean? When I see this error message, my terminal 
does not refresh and the data fields are filled with ‘ * ’?

A: Answer: Check the communication media (RS-485 cable). Verify proper wiring, and 
communication protocol settings on both your PanelView Component HMI and 
Powermonitor 1000 device.

3. I do not like the PanelView Component navigation. Can I show other metering parameters 
on the start-up screen?

A: The PanelView Component navigation is designed with the layout as described in this 
quick start. To customize the application, you can use the PanelView Component emulator 
to add on or modify the application. Reference the PanelView Component Building Block 
documentation for application development.

4. How can I change the Powermonitor 1000 configuration from the PanelView Component 
display?

A: The PanelView Component application is for viewing metering information only. To 
change the Powermonitor 1000 configuration, use the web page of the product or the 
built-in Powermonitor 1000 LCD display.

You can also customize the PanelView Component HMI. See Question 3.
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5. I see some of the data for the metering parameters, but it shows ‘ * ‘ on the least significant 
digit. What is causing that?

A: The metering parameter in the PanelView Component application is programmed with a 
fixed number of digits. Your data value is outside of the fixed digits. You need to 
customize the PanelView Component application for your specific situation.
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Rockwell Automation Support

Rockwell Automation provides technical information on the Web to assist you in using its products. At 
http://www.rockwellautomation.com/support/, you can find technical manuals, a knowledge base of FAQs, technical 
and application notes, sample code and links to software service packs, and a MySupport feature that you can 
customize to make the best use of these tools.

For an additional level of technical phone support for installation, configuration, and troubleshooting, we offer 
TechConnect support programs. For more information, contact your local distributor or Rockwell Automation 
representative, or visit  http://www.rockwellautomation.com/support/.

Installation Assistance

If you experience an anomoly within the first 24 hours of installation, review the information that is contained in this 
manual.
You can contact Customer Support for initial help in getting your product up and running.

New Product Satisfaction Return

Rockwell Automation tests all of its products to ensure that they are fully operational when shipped from the 
manufacturing facility. However, if your product is not functioning and needs to be returned, follow these 
procedures.

Documentation Feedback 

Your comments will help us serve your documentation needs better. If you have any suggestions on how to improve 
this document, complete this form, publication RA-DU002, available at 
http://www.rockwellautomation.com/literature/.

United States or Canada 1.440.646.3434

Outside United States or 
Canada

Use the Worldwide Locator at http://www.rockwellautomation.com/support/americas/phone_en.html, 
or contact your local Rockwell Automation representative.

United States Contact your distributor. You must provide a Customer Support case number (call the phone number 
above to obtain one) to your distributor to complete the return process.

Outside United States Please contact your local Rockwell Automation representative for the return procedure.

http://literature.rockwellautomation.com/idc/groups/literature/documents/du/ra-du002_-en-e.pdf
http://www.rockwellautomation.com/support/americas/phone_en.html
http://www.rockwellautomation.com/support/
http://www.rockwellautomation.com/support/
http://www.rockwellautomation.com/literature/
http://www.rockwellautomation.com/locations/
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		QR		B2 primary, B3, B5		D5, D6		Quick Reference		1		5		Post / External

		QS		B2 primary, B3, B5		D5, D6		Quick Start		1		5		Post / External

		RM		B2		D5, D6		Reference Manual		1		5		Post / External

		RN		B3		D5		Release Notes		1		5		Post / External

		SG		B1 Primary, B4		D5, D6		Selection Guide Colour		5		50		Presale / External

		SG		B2		D5, D6		Selection Guide B/W		5		50		Presale / External

		SP		A1, A2, A3, A4		NA		Sales Promotion NOTE: Service profiles are to be assigned the PP pub type.		5		100		Presale / Internal

		SR		B2, B3		D5, D6		Specification Rating Sheet		5		100		Presale / External

		TD		B2 Primary B3, B4, B5		D5, D6		Technical Data		5		50		Presale / External

		TG		B2, B3		D6		Troubleshooting Guide		1		5		Post / External

		UM		B2 Primary, B4		D6		User Manual B/W		1		5		Post / External

		WD		B3		D5		Wiring Diagrams / Dwgs		1		5		Post / Internal

		WP		B3 Primary, B5		D5		White Paper		5		50		Presale / External

		** Minimum order quantities on all JIT items are based on the publication length. **

		Publication length		Minimum Order Quantity

		77 or more pages		1 (no shrink wrap required)

		33 to 76 pages		25

		3 to 32 pages		50

		1 or 2 pages		100

		Pre-sale / Marketing		All paper in this category is White Brightness, 90% or better. Opacity 90% or better

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		A1		4 color		170 gsm  2pp		100# gloss cover, 100# gloss text

		A2		4 color		170 gsm  , folded, 4pp		100# gloss cover, 80# gloss text

		A3		4 color		Cover 170 gsm  with           Body 120 gsm, > 4pp		80# gloss cover, 80# gloss text

		A4		2 color		170gsm Silk – 120gsm Silk		80# gloss cover, 80# gloss text

		A5		2 color		170gsm Silk – 120gsm Silk		80# gloss cover, 80# matt sheet text

		A6		1 color		170gsm Silk – 120gsm Silk		80# gloss cover, 80# matt sheet text

		A7		4 color cover
2 color text
Selection Guide		Category being deleted		10 Point Cover C2S
50# matte sheet text

		A8		4 color cover		Category being deleted		50# matte sheet text, self cover

				2 color text

				Selection Guide

		A9		2 color		100gsm bond		50# matte sheet text, self cover

				Selection Guide

				Gray shading indicates Obsolete Print Catagories

		Post Sale / Technical Communication

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		B1		4 color cover		270gsm Gloss 100gsm bond		10 Point Cover C2S

				2 color text				50# matte sheet text

		B2		1 color		160gsm Colortech & 100gsm Bond		90# Cover
50# matte sheet text

		B3		1 color		100gsm bond		50# matte sheet text, self cover

		B4		2 color		160gsm Colortech & 100gsm Bond		90# Cover
50# matte sheet text

		B5		2 color		100gsm bond		50# matte sheet text, self cover

		Catalogs

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		C1		4 color cover		270gsm Gloss 90gsm silk		10 Point Cover C2S

				4 color text				45# Coated Sheet

		C2		4 color cover		270gsm Gloss 80gsm silk		10 Point Cover C2S

				2 color text				32#-33# Coated Sheet

		JIT / POD		All paper in this category is White Brightness, 82% or better.  Opacity 88% or better

		Category		Color Options		AP, EMEA Paper Requirements		Canada, LA, US Paper Requirements

		D1		4 color		170gsm white silk		80# gloss cover, coated 2 sides

		D2		4 color		120gsm white silk		80# gloss text, coated 2 sides, self cover

		D3		4 color		Cover 170gsm  with           Body 120gsm		80# gloss cover, 80# gloss text coated 2 sides

		D4		1 color		160gsm tab		90# index

		D5		1 color		80gsm bond		20# bond, self cover

		D6		1 color		Cover 160gsm tab with Body 80gsm bond		90# index, 20# bond

		D7		2 color		160gsm tab		90# index

		D8		2 color		80gsm bond		20# bond, self cover

		D9		2 color		Cover 160gsm tab with Body 80gsm bond		90# index, 20# bond

		D10		Combination: 4 color cover, with 2 color body		Cover 160gsm with           Body 80gsm		90# index, 20# bond

				Gray shading indicates Obsolete Print Catagories

		Just In Time (JIT) or Off Set (OS)?

		Use these guidelines to determine if your publication should be JIT (just in time/print on demand) or if it would be more economical to print OS (offset/on a press). OS print jobs require an RFQ (Request For Quote) in US. If your job fits into the “Either” category, an RFQ is recommended, but not required. In the US, RA Strategic Sourcing will discourage or reject RFQs for jobs that fall within the JIT category. Guidelines differ for black & white and color printing, so be sure to check the correct tables.

		Black & White Printing

		Color Printing

		Color Printing





Print Spec Sheet

		JIT Printing Specifications				RA-QR005G-EN-P  -  3/29/2010

		Printing Specification		YOUR DATA HERE		Instructions																																				NO

		(required) Category:		D6		Select Print Category A,B,C or D from category list, on "Introduction_Catagory Types" tab																														11” x 17”				LOOSE -Loose Leaf		YES		Pre-sale / Marketing				TOP

		(required) Finished Trim Size Width:		8.5” x 11”																																8.5” x 11”				PERFECT - Perfect Bound				A1				LEFT

		(required) Publication Number :		CC-QS017A-EN-P		Sample: 2030-SP001B-EN-P																														3” x 5”				SADDLE - Saddle Stitch				A2				RIGHT				CORNER

		Use Legacy Number		NO		YES or NO																														18” x 24” Poster				PLASTCOIL - Plastic Coil (Coil Bound)				A4				BOTTOM				SIDE

		Legacy Number if applicable:				Sample Legacy Number: 0160-5.33																														24” x 36” Poster				STAPLED1 -1 position				A3

		Publication Title:		Energy Management Connected Components Building Block - Powermonitor 1000		Sample: ElectroGuard Selling Brief
80 character limit - must match DocMan Title																														36” x 24” Poster				STAPLED1B - bottom 1 position				A5

		(required) Business Group:		Marketing Commercial		As entered in DocMan																														4” x 6”				STAPLED2 - 2 positions				A6

		(required) Cost Center:		19014		As entered in DocMan - enter number only, no description. Example - 19021		CMKMKE CM Integrated Arch - 19021
CMKMKE Market Access Program - 19105																												4.75” x 7” (slightly smaller half-size)				THERMAL - Thermal bound (Tape bound)				A7

		Binding/Stitching:		SADDLE - Saddle Stitch		Review key on right...		Saddle-Stitch Items 
All page quantities must be divisible by 4.
Note: Stitching is implied for Saddle-Stitch - no need to specify in Stitching Location.
80 pgs max. on 20# (text and cover)
76 pgs max. on 20# (text) and 24# (cover)
72 pgs max. on 24# (text and cover)

Perfect Bound Items
940 pgs max. w/cover (90# index unless indicated otherwise)
70 pgs. min. for spine without words
200 pgs min. for spine with words 

Plastcoil Bound Items
530 pgs max. of 20# (if adding cover deduct equivalent number of pages to equal cover thickness) (90# index unless indicated otherwise)

Tape Bound Items
250 pgs max. on 20# no cover
240 pgs max. w/cover (90# index unless indicated otherwise)																												4.75” x 7.75”				THERMALO - Thermal Bound (Tape bound - offline)				A8

		(required) Page Count of Publication:		40		Total page count including cover																														5.5” x 8.5” (half-size)								A9

		Paper Stock Color:				White is assumed.  For color options contact your vendor.																														6” x 4”								Post Sale / Technical Communication

		Number of Tabs Needed:				5 tab in stock at RR Donnelley																														7.385” x 9” (RSI Std)								B1

		Stitching Location:				Blank, Corner or Side																														8.25” x 10.875”								B2

		Drill Hole YES/NO		NO		All drilled publications use the 5-hole standard, 5/16 inch-size hole and a minimum of ¼ inch from the inner page border.																														8.25” x 11” (RA product profile std)								B3						None

		Glue Location on Pad:				Glue location on pads																														8.375” x 10.875								B4						Half or V or Single Fold

		Number of Pages per Pad:				Average sheets of paper.. 25, 50 75,100 Max																														9” x 12” (Folder)								B5						C or Tri-Fold

		Ink Color				One color assumes BLACK / 4 color assume CMYK / Indicate PMS number here…																														A4 (8 ¼” x 11 ¾”) (210 x 297 mm)								Catalogs						DbleParll

		Used in Manufacturing:		NO																																A5 (5.83” x 8.26”) (148 x 210 mm)								C1						Sample

		Fold:				Review key on right...																																												Short (must specify dimensions between folds in Comments)

		Comments:																																										C2						Z or Accordian Fold

		Part Number:																																										JIT / POD						Microfold or French Fold - designate no. of folds in Comments - intended for single sheet only to be put in box for manufacturing

																																												D1						Double Gate

																																												D2

								Folds
Half, V, Single                 C or Tri
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Z or Accordian                        Microfold or French
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